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Introduction

* Li-ion batteries (LiBs) in modern life A
* High energy density D - 0=
* Low self-discharge
* Rechargeable \E/

« Battery Management Systems (BMS) T Na
* Performance SRS *‘\9
« Safety )
* Reliability

* BMS need State-of-Charge (SOC)

* SOC is the remaining charge in battery
* Not measurable (Need to be estimated)
e Complex dynamics (Need to be predicted)

Li-ion in anode

* Current technology limits the operating range of batteries o 100 E;P
............... * '61
. 3.0
» Objective g
* Create accurate, efficient, and control-oriented SOC model >0C 2.5¢ , , ,
: : (Range) 0.00 025 050 0.75
* Develop algorithm to estimate SOC SOC [-]
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Outli

* Literature Review on SOC Estimation and Modeling

* Objectives

e Methods [ Prior Knowledge }—

| Experimental Design I:

o Interpretable data-driven model

- ¢
{ | Domain Knowledge |«

o Physics-inspired model "_| DEif) Gallizsiion |_l [ Fitting Criteria_j+———
) | Validation Data | | Training Data |
o Tuning parameters
o Noise mitigation | . TR e
o Framework to estimate SOC No
Evaluate
o Experiments Yes
« Results and Discussion Physics Informed Model |« Filtering & Co-estimation |«

e Conclusion and Future work
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Battery Dynamics Modeling

SOC and Voltage have Complex Dynamics

S /\ —

Equivalent Circuit Machine Learning
Empirical Models Mechanistic Models
P Models (ECM) Models
|/j \ O 9, (0 Tuec) + 15
% %, (0,F,cs)
Look-up Table % > o
Heuristic techniques VT T + Vo T Ince = =1
/ V0V, ¢ = jH
Simplicity Fidelity

sites.temple.edu/dslab/ 4/51



I I H
|DSLab Introduction > Review > Objective > Method > Simulation > Mil’:li(g);st?on > Experiment> Estimation > Conclusion>

Dynamical Systems Lab

Battery Dynamics Modeling: Empirical Models

e Historical data 4

e Statistical methods

Current [A]

 Coulomb counting; e.g. Ghoulam et al., 2022

v

 SOC-voltage mapping; e.g. Xing et al., 2014

4.0
v’ Very simple > 35
X Very sensitive to operating condition g

3.0
X Require large and high-quality datasets to build model

2.5

0.0 0.2 0.4 0.6 0.8
SOC [-]
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Battery Dynamics Modeling: Mechanistic Models (1)

* Expressthe process inside the battery with analytical equations
* Electrochemicalreactions

* Heat and mass transport

Discharge e~ Load e Charge
— — AN — —
L V¥ |
. | Negative Electrode (Anode) Separator _ Positive Electrode (Cathode)
Voltage 4 Q l " ”ml
Current |— SElFilm Lithium in Electrolyte Phase
:> 3 ' ») § w S ———=-Electrolyte ~—f— Crystal ?
Temperature ': -': § g/‘k L‘TL-T Li+‘\‘_\o§§%§§§o %8 g
: ) 35 ¢ IR Ce Li*Discharge FRECEEGS g_ 5
= Te—) S~ S —— Lol Jd Juy S
— 65 | N ctan © frium'n Sojid Phss P H
5 's “,’ ; l‘,l .----9.__‘ . l-_ ’ sep _ / oy i+ % g
ORT ] T ol Lt Jn e el Jn e 30
25N & o; O < DOSP=| @} cp'\,-ﬁc%»
. . o ) = Q
» Binpkfiddairmbaedsy (Started by Newman’s Group) s | (/3 8 i e
* Baggld Pario!b iMhedsi ¢SRME Zhanhodedi Bogle 20410, 1993 e —— ' —

I Active Particles || Bin"t':!er/Additive " Porous Se

* BRIglanBdriove Magiagnitine kedtars| gteabn @8 d perature (SPMeT); Park et al., 2021
* Doyt eubartiNeiMoate ([DFRMP Majdabadeatal d¥0dbnics); Thomas et al., 2002 Y
v Stk e flor coraiyeli a me o plifgizasion % o

Negative
Electrode

sep _

Positive

SR Electrode
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Battery Dynamics Modeling: Mechanistic Models (2)

v’ Capture the dynamics of the modeled processes, detailed insight

v/ High interpretability, allow for design and performance optimization
v’ Extrapolatable to a wide range of conditions for complex models

X Require many parameters, several not available

X Based on idealized principles, not always apply

X Only predict the modeled phenomena

X Computationally expensive with added complexity

Model Number of parameters Computational Complexity
DFN 33 High

SPMeT 31 Medium
SPM 20 Low
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+» Equivalent Circuit Model (ECM)

* Express the battery’s dynamic with electrical components as 4
R; Ry = i NMC @25C
RO —_1— —L 1 o - NMC @5C ‘
 — Vs Ven e \ ===—NMC @45C
T + ” = —~ {— “+ § 3.5 L . -
C C =
1 n é 1o /"—
@) Vo500 v 3
& 25
Q.
\ A (@]
2.0 >
20 40 60 80 100
State of charge (%)
« ECM with simple passive electrical elements; e.g. Schmidt et al., 2016
* Determine Open circuit voltage (OCV) from voltage and current =
» Estimate SOC via SOC-OCV mapping = ol ol =
7 anode .| > B |>|3 cathode 2
. . o . BN (e graphite) | E|E| E|BIE| @iMoy | £
 ECM with fractional-order or distributed elements; Wildeuer et al., 2021 Bl o8] 2 (52 _ £
R Ol » | o é <

* Using impedance spectra

R('u
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+ECM
v’ Use measurable data (current and voltage)

 ECM with passive electrical components:
v' Simple with low computational cost
X Narrow operating range due to lack of physics-based information
X Need to use look-up tables with many sets, still limited due to being linear

« ECM with fractional-order or distributed elements:
v’ Connections to internal processes of LiBs
v Larger operating conditions
X Require impedance spectra
X Need specific devices with careful experimental control
X Not suitable for real-time applications

High voltage
grid integration

smart grid
integration

e-mobility

a8 » ﬁl diagnosis
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Battery Dynamics Modeling: ML (1)

**Data-driven Model/Machine Learning
* Express the battery’s dynamic from measurable data

* Black box modeling

. I1(t )—a»( ML-Methods
* Support vector machine (SVM); Feng et al., 2019 |
* Clustering with genetic algorithm; Hu et al., 2016 . o
* Neural network (NN); How et al., 2020 ¥ie . >
* Recurrent NN; Vidal et al., 2022
* Long short-term memory recurrent NN; Chemali et al., 2018
|
IR
]
=
Machine
Bt Learning
Model
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Battery Dynamics Modeling: ML (2)

**Data-driven Model/Machine Learning

v No need for internal parameters (using measurable data)

v Adaptable to new chemistries or conditions by retraining

v’ Can use novel features instead of traditional metrics (e.g., voltage, current)

v Low implementation cost, suitable for real-time applications

X Require rich and informative dataset to capture operating conditions

X Needs an extensive set of data to build model

X Risk of overfitting with complex algorithms

X Can lead physically inconsistent results and lack interpretability (no connection to physics)

X Too many features reduce stability (ill-conditioned problem due to correlated terms)
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Battery Dynamics Modelin

L

Equivalent Circuit Machine Learning
Models (ECM) Models

Empirical Models Mechanistic Models

ECM+ML Mechanistic+ML

— R(Q,M(Q,5)) =0

- @ N
- 00—0
—  lo—o0-
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 ECM: Increasing operating range and accuracy
« ECM + Machine learning

* ECM + deep learning; Su et al., 2023
« ECM+ NN; Borah etal., 2024

« ECM + Kalman filter; Yao et al., 2024

Measurement

v’ Refine estimates; suitable for aggressive input
v Mitigate noise effect Input. —— S0¢
v Extend ECM operating range

5

X Lack of interpretability

X Require large datasets for training

X Limited accuracy in low SOC regions
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Battery Dynamics Modeling: Hybrid Models (2)

* Mechanistic: Increasing accuracy and reducing computational time ‘“ﬂ”“ﬂ‘.“* =
* SPM + Machine learning

 SPM +recurrent NN; Saehong Park et al., 2017 Physica [
 SPM with thermal dynamics + feed forward NN; Tu et al., 2023 e
* Mechanistic models + Kalman filter
« SPM + Kalman filter; Fang et al., 2014
 P2D + Kalman filter; Smiley et al., 2018
* Physics-informed NN, Hofmann et al., 2023

* Solving SPM with electrolyte equations with NN; Xue et al., 2023
v/ Improve accuracy by capturing complex unmodeled dynamics with ML
v’ Extend operating range of simplified model (ECM and SPM)
X Require large datasets for training machine learning

>

Y

Input current II V.
N | | RN

Bias term o : Physics — informed activation function

X Need many internal parameters for mechanistic models {
Inputs

X Increase complexity in balancing mechanistic and machine learning
components

—0

Output

s\s|g =

2 : Weighted sum
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Proposed Approach

* Desired Model: X Dynamics of LiB is highly nonlinear

v Interpretable and control-oriented data-driven model
* Uncover governing equations not fitting data only

v : . SINDy challenges:
Gonnection to physics . csciecting library terms
v Perform well in unseen data — XSelecting sparsification parameters

* Interpretable input/output modeling techniques:

* Dynamic mode decomposition (DMD); Tu, 2013
* Approximate linear system

e Sparse identification of nonlinear dynamics (SINDy); Brunton et al., 2016
* Nonlinear reduced order model through sparsification of a library of potential terms
* Require remarkably less data comparing to NN
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Objecti

** Main objective: Develop a tractable data-driven model to discover the governing equations of Li-ion
batteries

(JHypothesis: Voltage and SOC dynamics can be represented by a few terms from the measured data,
and SOC levels can be accurately estimated via these learned dynamics

» Aim 1: Discovering Battery's Voltage and SOC dynamics
* Create a nonlinear interpretable data-driven model for Li-ion battery
* Enhance the modeling technique by including physics-inspired terms
* Formulate a multi-objective cost function to capture the dynamics

» Aim 2: Robust Modeling with Noisy Data
* Extend data-driven model using a Joint Unscented Kalman Filter to mitigate noise effects
* Develop a co-estimation framework to update model parameters using measurement data

» Aim 3: Data Generation and Model Development
* Generate data from a detailed cylindrical cell battery model
* Design experiments on a single cell at different temperatures
e Conduct experimental studies and collect data
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Roadmap

* Discover governing equation of Li-ion batteries

. Initial model i\\u PyBaMM
* Using the measurable data Simulation data
* Physics-inspired e l ...................................

* Generalizability
Sparse Identification

* Reduce measurement noise effect |

* Using Joint Unscented Kalman Filter Contribution v
Link to physics Tuning parameters

e Co-estimation framework

Experimental data

............................... 1

Noise mitigation Online estimation
|
Future work ‘
Cell designing Fast charging Complex systems
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Sparse ldentification of Nonlinear Dynamics

* SINDy is based on sparse linear regression; Brunton et al., 2016

* Results in reduced order nonlinear model x = x + 3u?

* Detect the governing equation
« Notable extensions to SINDy x o 1lx x? x> u UZ_ =
* SINDy with control (SINDyC); Brunton et al., 2016 ®

* AIC-inspired on training data; Mangan et al., 2017
* Constraint dynamics; Loiseau & Brunton, 2018 _
* Including switching dynamic; Li et al., 2019; Mangan et al., 2019
 PDE; Messenger & Bortz, 2021

* MPC; Fasel et al., 2021 L0 [ J U7,

* Sensitivity analysis: Naozuka et al., 2022 W—/

« Ensemble model; Fasel et al., 2022 Library: ©(X, U)

* There are several extensions; however, they mostly left the choice of library terms and
sparsification parameters which based on the original formulation overfits the model
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Sparse ldentification Method

1 0 1 —1.4 0
x[k + 1] = f(x[k /l'x | + Jx?[k] + fulk] + Ax[k]u[k] + Zx? [k]u?[k] + fsin[k] ~ <—
Library of potential terms: x[k + 1] = x?[k] + 4x[ku[k] — 1.4x?[k]u?[k]
O(X, U) = X X2 i/ X.U XZ.UZ sin.(X)
X =|[x[k] x[k+1] - x[k + m _ 1]].T,X’ = [x[k.+ 1] x.[k +2] - x[k+m]]T

U=[ulk] ulk+1] - ulk+m—-1]]T

* By defining sparse vector of coefficients =:

X' =0(X,U)=
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ldentifying Sparse Vector of Coefficients =
E=[& & - &l

* Ridge Regularization problem:

£* = argming|| X" — OZ||, + AE[l2+ &4 !

\ 4
2
[}
)
¢}

A: regularization parameter

e Suitable for correlated terms
E(1&] < &) ==0

* Promoting sparsity: Sequentially thresholded ridge
regression (STRidge)

© Entif|&] <> & =0

No

Yes

E*=[Se1 8(2 fn]T
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Tuning Sparsification Parameters (4, ¢;j,)

* Original Approach: Akaike information criterion (AlIC)-inspired loss function:

AIC = 2N — 21n(L), L is the maximum value of the likelihood function

1X' —0(X, U)E||3
N

+e>+2K

L(E) = Nln(

k is the number of nonzero coefficients in =, and N is the number of measured data in time.
€ < 1 to avoid overfitting the data.

* Goalis to balance accuracy and complexity

5= argminEHX — Q=

_+ AlIEll; + EnllEllo
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Limitations of Generic Model

**Preliminary results using SINDy: predict voltage with generic terms and AIC cost function

“*Very limited operating condition
* Lack of connection to physics

* Exacttermsto be included in the library
* Adding too many terms results in ill-conditioned problems with correlated terms

* Cost function using only training data

> Next Steps
v' Create physics-inspired library "
v Design multi-objective cost function Validaton
— — —Identified
v Predict both voltage and SOC simultaneously _ | |
% o 3
2 f '
5t
-10 : : :
0 0.5 1 1.5 2

Time [s]
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NL Control-Oriented Model of Batteries

* Measurable data
* Voltage and SOC are the states ([V SOC] = X)

SOC,V
e Currentistheinput (I = U) 4>[ Battery }7

SOC
[Vi+1,S0Cg41] = f (Vi ,SOCy, I;)
+ v
Vk+1 = G(Vk) SOCk} Ik)El I'— —(A
SOC = 0((V,,SOC,, I,)= v
o1 = OV, SOCk, )& oo |
e Data to create the data-driven models SOC, V

e Python Battery Mathematical Modelling (PyBaMM)
e 21700 cylindrical Li-ion cell with material NMC 811 parameters set (5000 mAh)
 DFN Model

* First step: determine a library based on battery physics
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Physics-Informed Library (1)

* DFN model

e Solid and electrolyte concentrations:

Discharge e” Load e Charge
—_— o s— VV\I e — D —
| __Negative Electrode (Anode) Separator _ Positive Electrode (Cathode) X
© i X g 1 | ” |
! ! | !

|——= SEIFilm Lithium in Electrolyte Phase
— b
+ g . Electrolyte € Crystal =

C S .

ocs (x,7,t) = 19 Df aS(xrt) 82/ Lif), . 9 ~g 3
35t 25 =87 v \<><><><>\><>o<> 3 e
3 3 O g ¢ Ll.. Discharg OQOQOOQO z ?)
Ce Ce = | N N S N T NN LAO00000 5 L
(x t) = EP [D —(x, t)] FL+ I(t) o s\ Gharge Li Lithium in Solid Phase 5_2_ -
S 2 \LI_ [ ST (o= N T ’I'.I e =
= é\'ﬁ" ; (Li ,' ———————— A Lit Lit H\,HLer /"3 S
83 ‘ T 1@\ s e
3 P .-f‘\,’“ ™ ,-" ) = =

* LY Lt 5 Ei

L1 A (Lit) 4 . (Li .

‘ P ’,- gl el f b "-J(--_J \—/I

Active Particles Binder/Additive Porous Separator " Binder/Additive Active Particles
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Physics-Informed Library (2)

e DFN model: sin(-), exp(-)

e QOverpotential (Butler-Volmer):

Discharge e Load e~ Charge
N o — VV\I e — -
I . Negative Electrode (Anode) Separator Positive Electrode (Cathode)
W g " > > < 5 ]ml
! i i |
(e D) 1 =00 [si haaF . )] |——= SEIFilm Lithium in Electrolyte Phase
S(x, t) ==1i5(x,t) [sinh——n—(x,t - >
Ja X F oY RT i £ < ST - Electrolyte € Crystal 3
8 :/’\__ Liv) (BT [ &*) (L Lf"' 0“‘ PO & Q E
% E . (D L+ (k%) (Le*) [Le¥] (LD B ‘\"\@?‘O—Q?Q? 3 g
a6 S 1) (1) (b0%) (ue® Ce Li" Discharg SOORBOGS % 3
— Ta— S, =T S PPy O
SN 000000 !
5 Li Lithium in Solid Phase » 5
= + - Charge > 3
585 | Li f Zhare x EgH
U 0 L'l'- l." I|I ) Q —
s § Y ! ,/ Lit ]n(x) J}l-l'- ———————— {77 R | B Lit Lit l'l.l Lit ,g g)
253 A ) 2 [ ows P )\ A 3
o - : 4 { i — %
° S @ / PAP T @ ¢
i < ) ’ ! Y@ AT
O O Do ( - £ O S
v

Active Particles _||"Binder/Additive |[ Porous Separator || Binder/Additive || Active Particles

sites.temple.edu/dslab/ 25/51




I I H
|DSLab Introduction > Review > Objective > Method > Simulation > Mil’:li(g):teizon > Experiment> Estimation > Conclusion>

Dynamical Systems Lab

Physics-Informed Library (3)

e DFN model: sin(+), exp(-), sinh(-)

* Electrolyte’s electric potential: 9 2RT dInfec ¢ i (x, )
y P ¢e(x,t):—(1—t9) 1+ 2 (x,t) |9 In—(x,t) — =
. . . d0x F dlnc, 0x K
Solid electric potential:
SOC: Discharge e Load e Charge
- — — N —
| l - Negative Electrode (Anode) Separator Positive Electrode (Cathode) ”m
QL > > .
| " | |
|— SEI Film Lithiumd ctrolyte Phase

¢s () =0t t) + @e(x, ) + UH(css) = FRFjr (1) | |2 ﬂfcpe >
S~ TR - Electrolyte Crystal c
S 9 - GIG1CIG] L 998000 o 8

-1 i oy el Yo 99980500 "2 2

n n — — Qo r-‘ L) (%) (1) (Le* Ce Li DISCharg 0?909090 & 3
V(t) = ¢5(07,t) — ¢s (07, 0) £ B ; e E L G6S0ES S o

O | Li Lithium in Solid Phase o 35

55 | Li* Sharge = X 28
O a { o i + Q .y
= 9 Wl S s (LY YN (Lt -----=2 Lithdememmon - Lit Lit \(Lt = Q
1 t g B\, ; - 4 P < 6 =
Soc(t) =50c(0) ——j nldt a0~ VAR 3/ LL \ \ o1
Ca 0 O [/‘ﬁ r';' = .? & rw ,)( 9 I=- 'l r'\.\ o

* ! L[ LAY
LiY) A (LiY) 4 . LE :
‘ Sl O il P v

- - - I = g : . l‘-
Active Particles Binder/Additive Porous Separator " Binder/Additive Active Particles
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Automated Optimization Algorithm

Three datasets for modeling: Data set

Training dataset:

* Building the model
* Input and output of this set are known Trasléltmg << Tuning >+ va lsejtlon

Validation dataset: Model complexity : :
é“ :g
| \9/ Optimal model

Cost

* Optimizing the hyperparameters of the identified model

* Test dataset:
* Evaluating the performance of the identified model §
Model complexity i
Evaluating model
2" = argming || X’ — OZ||, + Al|E]||, + &4lIEN on Test set
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Training Dataset

* Electrical current is employed to generate data

e Stochastic current signal up to 2C/4C-rate charge/discharge with 50 ms sampling time

Design Space

SOC [-]
09

0.85
0.8

[\
-}

10.75

[
-

10.7
10.65

Current [A]
()

10.6

500 1000 1500 2000
Time [s]

—_
-

0.55

-

0.5

0.45

-10 -5 0 5 10 15
Current [A]
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Validation Dataset

EPA aggressive highway drive cycles for validation

e USO06 drive cycle * Current profile

USO06 or Supplemental FTP Driving Schedule
Sample Period = 596 seconds - Distance = 8.01 miles - Average Speed = 48.37 5

20

80 + Z
£70 ¢ = 0
E -
\60 T :
b O
$ 50+ E
@ 40 1 S -5+ 1
L] @)
L 30 T
=
[ 4
> 20 -10 ! ! ! ! !

10 +

a 0 100 200 300 400 500 600

CRe SN2 BRTIERREANLBsIEERSRRE Time [s]
- - - 0NN NN MM MNN YT T T F DN NN
Test Time, secs
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Test Dataset

EPA urban drive cycles for test

* Urban Dynamometer Driving Schedule e Current profile
(UDDS)

EPA Urban Dynamometer Driving Schedule
Length 1369 seconds - Distance = 7.45 miles - Average Speed = 19.59 mph 4
&0
~ 2 I b
50 A
£ =
E - 0 |
~ 40 o
)
: S, ]
&30 1 = -
o O
© 20 - 4+ .
£ 4
>
10 4 _6 ! ! ! ! ! !
0 0 200 400 600 800 1000 1200 1400
O N F W 00N T WO O N T 00O N T W DO N T WL O N .
PR RN TYRLSERRERERRETIZIRNE Time [s]
Test Time, secs
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Introducing Hyperparameter Formulation

* The sparsification parameters are tuned with the training, validation set and number of terms
/rlnginJ(E) = p1E:(x, %) + poE,(x,X) + p3K

'Sth

Sparsification Parameters }

Evaluate

Training set |
STRidge | Active terms_| Discovered Hyperparameter NRMSE []
Data Regression Model Tufler 1074 107!
Valic‘lration Evaluate I
Data Validation set | 102
107 |
o i ! 5 - - <
E* = argming||X" — OZ||; + Al[Ell; + $enllEllo - 10°?
107 ¢
- Ix' -ex.0E|;
AIC: L(E) =mIn +¢€)+ 2K 10
m -7
10 '
107 1o° 107 1070 107 107
: (1214 £, ) Wl
(x, %) = Z X[K] AIC of the training data NRMSE of the validation data
sites.temple.edu/dslab/ 31/51




I I 1
|DSLab Introduction > Review > Objective > Method > Simulation > Mil’:li(g);st?on > Experiment> Estimation > Conclusion>

Dynamical Systems Lab

Optimal Voltage Dynamics Model

* Number of active terms depends on the hyperparameters (4, &)

* Red region suggests diminishing returns

«1074 Training Data Validation Data
—®e—0 T® T T T T T T
14 ¢
12 ¢
[\
10 |
T o8fe e LY P ZIO'I‘ .
[
% 7 w ° o ®®
S 6 p= D
R 1~ ° “
Z Z [ ] » O [ [
° P B’ © Qe At Asasnd
2 o P
4 ° 10 o oo
° o
°
®e? coSpas
‘ o °.~MM | . . j
0 20 40 60 80 100 0 20 40 60 80 100
Number of Terms [-] Number of Terms [-]
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Simulation Results (1)

* Voltage and SOC are calculated simultaneously

* Training data NRMSE
 Voltage: 3.2x10~*

« SOC:10°8
4.5 T T I T 1 T T T T
';' —— DFN simulation — — —Identified _ —— DFN simulation
';' 4 o — — —Identified
=] S
=35 2
> 0.5+ 7
3 | | | | | | 1 |
0 500 1000 1500 2000 0 500 1000 1500 2000
Time [s] Time [s]
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Simulation Results (2)

 USO6 validation data NRMSE:
 Voltage: 6.1x1073
e SOC:2.2x107°

" Tdentified

Voltage [V]
I\

| 45‘70 | 45‘80 I45l90 46‘0|0 46‘10 | |
0 1000 2000 3000 4000 5000 6000
Time [s]

—— DFN simulation
— — —Identified

SOC [-]

0.5F 1

0 1000 2000 3000 4000 5000 6000
Time [s]

* UDDS test data NRMSE:
* Voltage: 6.3x1073
« SOC:2.8x1073

45 T T T T
— 39 7 ;
Z. el 7 lentified
o 4 371
%0 3.6
% 3.5 /
> 3.5 7050 7100 7150 7200
0 2000 4000 6000 8000
Time [s]
1 T T T T
_ —— DFN simulation
L — — —Identified
@)
o
N
0.5
0 2000 4000 6000 8000
Time [s]
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* Current Model
v Works for perfect measurement

v No uncertainty (e.g., with simulated data)

- Issue on actual implementation /Ofﬂl.nfl - Physics-Inspired Data-Driven Model
° N OiS d t b h H H l' 1 Tra'lnlng and Sparsification Evalluate
y data both in training and validation Validation data T Cr(,ss_vmdml
* Errorin estimations o P e Joeeeme S
e Solution for noisy data and improve estimation S AV : D, . Vaﬁszi?sﬁietj
* Kalman Filter - Adapt the model Online ]
v’ Mitigate noise effect N .
Test data SOC

v' Connect SOC dynamics and SOC-Voltage map

> Discovered — >
AV ) (v Dynamics |7
J
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Joint Unscented Kalman Filter

* Avoid needs for linearization, suitable for nonlinear systems

* Address uncertainty in voltage state and coefficients concurrently

. 1k + 1] = 8 11k] + wz|k] Nonzero sparse coefficients
t Vlk + 1] = 0, 11k]E, 1[k] + wy[k] | Voltage dynamics { NMC 811
* VLIk] = V]k] + vy[k] Noisy voltage data )
I — JUKF

* Update Vand &, ; with the noisy output (Voltage) l 1A
. - . NL —

Utilize the updated voltage for the SOC prediction , ied SoC
« SOC[k +1] = 0, 2 [k]Er,Z k]

sites.temple.edu/dslab/ 36/51



Noise > Experiment> Estimation > Conclusion >

|DSLab Introduction> P > Objective > Method >Simu|ation> Mitioation
Simulation Results with Added Noise (1)

* Voltage data has 5% Gaussian noise as a measurement noise

* Training data NRMSE

 Voltage: 1073
« SOC: 1.008x1077

— Actual

4.5

Z 4 708
& 9

<

= i @)

§ 3.5 — Actual 7 0.6

— — Model
3 l l l l 04 1 1 1 1
0 500 1000 1500 2000 0 500 1000 1500 2000
Time [s] Time [s]
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Simulation Results with Added Noise (2)

USO06 validation data NRMSE: « UDDS test data NRMSE:
 Voltage: 1.1x1073 * Voltage: 9.0568x10~*
« SOC:5.0963x107°> « SOC:1.1585x10~*
4.1F ]
> SIS a0 S VO N T W
? ) S ) \ Bl rl— ll\/\ sy l\ h
%0 %.()39 i ‘/ J' ,v : | ,,,/ l{
% .—o< 38 i ,l 1A | Y i\
> \ > ' Y . | |
36F N ‘—Actual — — Model —-—-Model+UKF| - 37+¢ ‘—Actual — = Model —-—-Model+UKF‘ | 1
3120 3140 3160 3180 3200 3220 3600 3650 3700 3750 3800 3850 3900 3950 4000
Time [s] Time [s]
1 T I 1 T I
— Actual — Actual
: 08~ —-—-Model+UKF | :()8 —-—-Model+UKF |
@) @)
Qo6 ] Qo6
04 L L L ! ! 04 ! ! ! ! ! ! ! !
0 1000 2000 3000 4000 5000 6000 0 1000 2000 3000 4000 5000 6000 7000 8000
Time [s] Time [s]
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Selecting Battery for Experiment

* NMC batteries: Efficient, dependable
* Less Cobalt: Reduce price

* Increasing Nickel: Higher capacity and lower weight

3%
 LGM50 21700 cylindrical cell with NMC 811 cathode Housing, other materials
4%
Separator
7%
Electrolyte
(Cwen ) s \
Mn (28%) Anoce — %
Cathode

24%
Labor, manufacturing,
depreciation

Average cost structure of Li-ion cell

https://www.bloomberg.com/news/newsletters/2021-09-14/ev-

]

Co (18%) battery-prices-risk-reversing-downward-trend-as-metals-surge
S o/ \ o/
NMC-111 BATTERY NMC-622 BATTERY NMC-811 BATTERY
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Designing Experiment

* Electrical current is employed to generate data

* 1C-rate: 4.8 A, fully charge the battery in 1 hour with constant current

**Max current for constant current charging: 0.3C-rate
e T =10°C, 25°C,40°C

CCCV charge

[ Input 1 (Stochastic) |

CCCV charge

| CCCV charge |
i=j+1]
| Input 2 (US06) |

[ Input 3 (UDDS) |

i

Yes

CCCV discharge
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Experimental Results

* Stochastic electrical current signal up to 1C/2C-rate charge/discharge with 50 ms sampling time

5 T
z 0 Design Space
T;) 4.4 Soc
5 F
= 42
O 10 <—>| <4+—> | <—I><—>I < | >
- . . 4 L
0 S 5 ccev 10 ngth% CCCV20 75 City 30 -
Time [h] PR
Q30 % 361
o >
gé 3471
= 321
)
Q, ‘ ‘
g 25 210 5 0 5
ﬁ Current [A]

15 20 25 30
Time [h]

-]
N
[E—
-]
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Tuning Sparsification Hyperparameters

* Multi-objective cost function

/rlnfitr,llJ(E) = p1E¢(x, %) + poEy (x, X) + p3K

Sparsification Evalyate | 104 : —o : : : : :
Parameters Cross-Validation i i i e"e ® Voltage * SOC ‘
: Best model | o o ~
l T i 4{7; /’I i — 2 E L x X x x x X x X
Create STRidge |Active terms | Cost o 4 : (1] 10° ¢ x ° x X 3
> . —> - > . Q ] ~ Y ([ ] x X
Data Library Regression l . Function Y~ I
: . x °
. Sparsification Parameters 10 : * *xjoboooe 00000000 "'f'?
Validation I Evaluate o
[ Data Validation set 0 3 10 15 20 25 30

Number of Terms [-]

Value for SOC Value for Voltage
Number of terms 9 9
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Model Using Experimental Data (1)

e calculate SOC with Coulomb counting:
SOC(t) = SOC(0) — % [y nelde

> 4 Measured | -
. ] Qdischarged ‘;‘ § — T L, |
¢ Qcharged ‘5303.5 3
o .
. . > 5550 . .
* Training data RMSE 30 2000 4000 6000 8000
 Voltage: 2.1x1073V .
a Time [s]
 SOC:8.6x10 1
_ Measured
_I‘ 055 -— | | [ MOdel
3057 PR
L 0.5
5000 . 5500 ! L
0 2000 4000 6000 8000
Time [s]
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* Aggressive highway validation data RMSE: e City test data RMSE:
 Voltage: 8x107*V * Voltage: 6x1074V
« SOC:9.9x1073 (ECM+EKF: 6.3)(10_2) « SOC: 1.2x1072
—_ — 4.2
> 4! Measured _ > 4 Measured
= TR (| Model+JUKF ©agl3sh N, TNl [ Model+JUKFE
a0 Bn .
23| 2367
S S 34137
> 3 L10000 10020 110040 ‘ ‘ > 3 o 1400014020 14040, ‘ ‘ ‘
0 5000 10000 15000 0 0.5 1 1.5 2 2.5
Time [s] Time [s] % 10*
1 1
e _ Measured —_ R Measured
Tl e Model+JUKF e 07 e L Model+JUKF
8 05+ %7E \\'_\\ RS __‘-:: -ECM+EKF |- 8 0.5 0.68 \\‘\\ .
@A 065 > e 2 loss
0 6500 7000 ZSOO 1 1 = S -~ 0 9000 9500 10000 ) )
0 5000 10000 15000 0 0.5 115 2 2.5
Time [s] Time [s] % 10%
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SOC Estimation: Co-estimation Framework

* Adding uncertainty in SOC dynamics due to noisy current and unknown initial value

* Address uncertainty in both states and coefficients concurrently

°|Ep1lk + 1] = B, 1[k] + wg k] Nonzero sparse coefficients
|\ Vlk + 1] = 0, 1k]E, 1[k] + wy[k] | SOC-Voltage map
o SOC[k -+ 1] = 01,,2 :k] ET‘,Z [k] + WS [k] SOC dynamiCS O;:liizieng o Physics-Inspired Data-Driven Model
« k] = VIk] + vy[k] Noisy voltage data Validation data
Online Integrated Model
* Update V,SOC and &;. ; with the noisy output (Voltage) Terdn ) ! : l <5

| Discovered ————

A 1:?__’ i)
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Co-estimation Results (1)
 USO6 Validation data

1 e
* |nitial SOC: 0.8 (20% uncertainty) = T B gi;‘lff
005 ECM+EKEF| -
 SOC RMSE after convergence: 0.0102 2 o
« ECM+EKF fails to estimate SOC % 5000 10000 15000
Time [s]
* Voltage RMSE: 0.0008V 05 |
_ TENG e Proposed
L —ECM+EKF
5 0.1 1
i
m
0 e
0 5000 10000 15000
Time [s]
; -- -Measured
‘3 Proposed
)
S
> | | |
0 5000 10000 15000

Time [s]
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Co-estimation Results (2)
 UDDS Test data

e - = =Measur
* |nitial SOC: 0.8 (20% uncertainty) 0 : R, et gzpos:f
D05 gy ECM+EKF | -
 SOC RMSE after convergence: 0.0130 3 T
 ECM+EKF fails to estimate SOC %0 5000 10000 15000 20000 25000
Time [s]
» Voltage RMSE: 0.0006V e
. TEN, O e Proposed
- —ECM+EKF
5 0.1 1
ta
0r . Jro —
* Battery tester voltage accuracy: +0.02% full-scale range (£0.0004V) 0 5000 10000 15000 20000 25000

 Similar to maximum absolute error of voltage (0.0004V) Time [s]

= = =Measured
Proposed

Voltage [V]

0 5000 10000 15000 20000 25000
Time [s]
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Co-estimation Result on Different Conditions

Evaluate the transferability of the model to cold and warm environments by only adjusting the coefficients

1
.08

 Temperature:10°C

0 0.6
S04l
021

 Temperature:40°C

Sngia ——US06 Measured | |

T USO06 Proposed |’

~~~~~ = = ~UDDS Measured | "

[=a UDD§ Proposed | -

0.5 1 1.5 2 2.5

Time [s] % 10*
RMSE SOC Voltage
US06 0.0283 | 0.0026 V
UDDS 0.0325 | 0.0019V

1 ; : ;
I M~ ——US06 Measured
L - R USO06 Proposed
Qo5 ~~«. /= = =-UDDS Measured| |
O .
A ‘\\UDDg ?roposed
0 5000 10000 15000 20000 25000
Time [s]

RMSE SOC Voltage

USo6 0.0144 | 0.0006 V

UDDS 0.0158 | 0.0005V
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Conclusion

Developed tractable data-driven modeling techniques for complex

systems: Nl PuBaMM

* Formulating nonlinear sparse modeling with hyperparameters Simulation data

« Tuning of sparsification hyperparameters via a novel cost function =~ ssssssesersssssssssnsnnaes l ...................................
* Augmented the technique with a joint unscented Kalman filter to work

with noisy data and co-estimation Sparse Identification
Contributions to energy storage systems: 1

* Detailed analysis of complex electrochemical models of Li-ion batteries e to Dhvsi )
to determine physics-informed library terms LS e LT T el =l

* Validated the modeling technique on DFN models

* Designed and conducted experiments to generate modeling data D
* Created a control-oriented, tractable, interpretable battery model :
i ] . Experimental data
* Developed a technique to determine voltage-SOC mappingtoreplace | ...l
the currently used look-up tables from extensive experiments 1
* Online SOC estimation via introduced co-estimation framework Noise mitigation T r—
* Validated performance across diverse operating ranges, proving I
robustness and adaptability I}
Improved Sparse Accurate SOC
Identification method estimation
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* Testing in other Operating Conditions: Assess model performance in extreme conditions

Fast Charging: Design optimal current profile using the model to reduce charging time

Applications to other Cell Chemistries: Evaluate and extend the model to other
chemistries (e.g., sodium-ion)

Ensemble Machine Learning: Improve model accuracy and generalizability

Adaptive Modeling: Evaluate model’s online adaption on aged cells
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Publications

Journals:

“Augmented Sparse Nonlinear Identification of Nonlinear Dynamics (aSINDy),” SIAM Journal on Optimization, (In Preparation)
“Online Co-Estimation of State of Charge and Voltage Dynamics of Li-ion Batteries via Physics-Inspired Modeling,” IEEE Trans. Transp. Electrif, (Under Review), IF: 7.2
“Homogenized Mechanical-Electrochemical-Thermal Model of a Lithium-ion Cell,” eTransportation, (Under Review), IF: 15

“The Impact of Lightweighting and Battery Technologies on the Sustainability of Electric Vehicles: A Comprehensive Life Cycle Assessment,” Environmental Impact
Assessment Review (2024), IF: 9.8

“A Data-Driven Framework for Learning Governing Equations of Li-ion Batteries and Co-Estimating Voltage and State-of-Charge,” Journal of Energy Storage (2024), IF: 8.9

“Data-driven Discovery of Lithium-lon Battery State of Charge Dynamics,” Journal of Dynamic Systems, Measurement, and Control (2023)

Conferences:

“Bootstrap-Based Sparse Modeling for Temperature-dependent State-Of-Charge Prediction of Batteries,” 2025 American Control Conference (ACC’25), (Under Review)
“Real-time Internal Short Circuit Detection in Li-ion Battery Modules During Field Use,” ACC’24

“A Physic-Inspired Machine Learning Nonlinear Model of Li-ion Batteries,” ACC’23

“Sparse Modeling of Energy Storage Systems in Presence of Noise,” IFAC-PapersOnLine (2023)

“Discovering Governing Equations of Li-ion Batteries Pertaining State of Charge Using Input-Output Data,” ACC’23

“Modeling of Li-ion batteries for real-time analysis and control: A data-driven approach,” ACC’22
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